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1. What’s 

1.1. Generalities 
RoomLightingCalc is a Cocoa Mac OSX application specialized to perform lighting calculations for 
prismatic rooms, such as monitoring the amount of energy, fixtures layout by type, quantity and power, 
control and verification of compliance with the law of the plants, etc... 

RoomLightingCalc works in metric or imperial units, runs on Apple computers running OSX, fully 
respecting the specific technology and implements OpenGL for rendering. 

The simplicity of use and the interface modeler through an initial dialogue of pre-project for rectangular 
rooms, L or cutted-corner, with the CIE method should not be fooled; with  RoomLightingCalc we can start 
calculations and wait for the results, then continue to verifications, both visually (on the virtual space 
generated by the Application) and technically (through the amount of developed data).  Calculations 
proceed on any surface both flat or not (eg biconvex surfaces such as spheres and ellipsoids), 
architectural objects, streets, monuments, galleries, exhibition halls, and any other setting, geometrically 
complex, difficult to outline and calculate through the use of the usual tables and/or diagrams. 

RoomLightingCalc has some implementable internal databases containing: 

• lighting sources catalogues and linked multi-currency prices files; 
• electrical wires catalogue and linked multi-currency prices files; 
• special pieces catalogue and linked multi-currency prices files; 

The working window projects objects within a three-dimensional space that displays the axial reference 
system and a plane of virtual modeling.   The light sources, calculated as volumetric sources, are 
managed entirely by the Application, which allows you to import, display, edit and format IESNA LM-63 
(ASCII text files normally used by manufacturers of lighting fixtures-North Americans), EULUMDAT 
(formed by European standards) and even drawings PDF or DXF (the Application converts drawings into 
photometry!) data files; photometric solids are summarized in 36 azimithal C-curves and 180 zenithal 
gamma-angles, while the color of the lamps is given by the color temperature or real color. 

RoomLightingCalc can export to RTF or RTFD a complete list, formatted according to user needs, of the 
installed products and special items, full of economic computing and electrical power. 

1.2. The Method 
After creating or importing the scene, the method used for calculations is the radiance. 

The objects of the scene to calculate are divided into finite elements, which assess the amount of direct 
illumination due to natural sources (sun and sky) and/or artificial. The method involves the calculation of 
multiple reflections (for the interior) until the complete redistribution of the illuminance (unless the user do 
not stop the calculation). In the event that the calculation has been interrupted, the user can resume from 
where it was suspended to take it to completion. 

The information available when calculation is done is both visual (screen image) and numerical for the 
required verifications. The final real view is built in real colors or in color-scale. 

1.3. Video output 
The individual surfaces of the object subjected to calculation are editable and can be projected on a 
plane and presented with the actual colors on both faces. Furthermore, the entire scene appears on the 
screen and can be modified in real time, because the Application keeps all lighting information previously 
calculated. 
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This means that the calculation time is long, but still proportional to the complexity of the scene and the 
number of the arranged light sources but, by counterpart, once completed, allow a total control of the 
scene, in real time and from whatever point of view we choose. 

RoomLightingCalc has also a tool section, which shifts the normal plane of the lens (the plane of the 
screen) forward or backward from the observer cutting, always in real time, the scene to verify the 
illuminament of interior spaces that are not visible. 

1.4. Numerical output 
The outputs of numerical type can be plotted on the surfaces projected on the plane and shown in iso-
value curves: 

• Illuminament horizontal, vertical X+, Y+, X-, Y-, semi-cylindrical and in main-camera direction; 
• Luminance; 
• RGB; 
• Contrast factor (C.R.F.); 
• Glare indexes (TI, G, U.G.R., C.G.I. and G.R.); 

The displayed curves can be represented in color overlaying the view, print directly, pasted to the 
clipboard or saved in one of the allowed export formats (DXF, PDF, JPG). 

1.5. What's the use 
It is clear that, after this introduction, the use of RoomLightingCalc is wide but targeted on well defined 
problems. RoomLightingCalc is a flexible, fast and simple tool to address and solve problems related to 
various professional activities as well as to different purposes of practical application. 

It is also a powerful and intuitive verification tool to assess the compliance of systems to specific laws. 
Finally, it allows the economic computation of the entire plan, including lighting fixtures, electrical wiring 
and special pieces selected from a user-implementable database in more currencies. 

RoomLightingCalc is, therefore, the ideal tool for: 

• dimensioning and color-choice for the lighting sources; 
• interior - showroom, auditorium, showcases, etc.; 
• optimization and choice of glazed surfaces; 
• choice of the plaster based of the real color lighting effect; 
• study of the shadows, owned and brought; 
• checks and controls for television and glare. 

1.6. Who needs it 
RoomLightingCalc is a Macintosh Application dedicated to professionals working in the industry, 
architects, engineers, designers, builders, and their professional needs. To large industries that design 
lighting, institutions that determine the sites of application, the engineers charged in audits of facilities and 
verification of compliance of plant. 
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2. Getting started 
At the beginning RoomLightingCalc asks for selecting or creating some folders in which the application will 
save all the libraries: 

 
If an empty folder was selected/created as library folder RoomLightingCalc asks if the user wants to fill it 
with the default content: 

 
Then the installation procedure for the libraries folder will end: 
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Finally RoomLightingCalc presents the window that permits to control rectangular rooms: 
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3. Workspace 
At the beginning, the Room-wizard dialog will be presented: 

 
Room shape may be: 

• rectangular with a generic ceiling; 
• L shaped, with flat ceiling; 
• cutted corner (and triangular for extension) with flat ceiling. 

In case of L-shaped or cutted corner will be activated two edit field that permit to 'cut' one room corner, 
following the next figures, in which X=Length, Y=Width: 

     
Ceiling of a rectangular room may be: 

• flat; 
• single slab (along X-axis); 
• single slab 90° (along Y-axis); 
• double slab (along X-axis); 
• double slab 90° (along Y-axis); 
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• barrel vault (along X-axis); 
• barrel vault 90° (along Y-axis); 
• cross vault; 
• dish vault. 

Colors may be chosen through a palette menu: 

 
in which is visible the original color (blue framed) and the active color (black framed) with its number (ex. 
#80), its reflection coefficient (ex. r=62%) and its RGB components in % (ex. RGB { 60, 79, 79} ). The 
'other' field permits to assign the color through the standard Mac dialogue. 

The source catalogue may be chosen through the button at the bottom of the source list, containing the 
name of the active one. 

To find some source it is present a find edit field under the source list: typing something inside it the 
Application will search for the sources whose name contains the typed characters. 

3.1. Selecting more than two lighting sources: Compare option 
In case of selecting more than two sources the user can activate the "Compare" tool that permits to 
evaluate the performances of the selected sources, presented in the second tab of the panel as in the 
following image: 
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3.2. Selecting one or two ligting sources: Verify option 
Lighting sources involved in calculation may be of two types (selecting two rows in the source table list by 
pressing the ⌘ (command) key), and the 'Staggered' check box permits to have such a type of layout. 

The procedure start once the user choose the lux level required and press the 'Verify' button: the 
Application presents the number of fixture needed to reach the required lux level. Then the only 
parameters it is possible to change without making new calculation are the row number, the layout 
(standard or staggered) type and the calculation grid. 

Pressing the button 'Create room' a new project will start with the values displayed in the dialogue, and 
the application shows the scene in 3D mode view. Following default settings, may be visible: 

 
• Global Coordinate System with the axis X-Y-Z in green color (always visible); 
• Active Coordinate System with the axis x-y-z in red color; 
• The graphic grid of the Active Coordinate System at z=0; 

3.3. Document Window 
For each Document the main window contains the model and some instruments depending on the type of 
visualization, but for each mode it is possible: 

• reposition the window with the title bar; 
• redimension the window from the edges and with zoom (green) and collapse (yellow) button in 

the title bar; 
• close the window whit the close (red) button in the title bar. 

Visualization mode may be: 

1. 3D view 
2. Plan view 
3. Result view 
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3.3.1. 3D View mode 

This is the mode in which the software presents a new document and the only one in which is possible to 
create and edit all drawing elements. 

The drawer contains a group of buttons: 

Setting dialog Escape (ESC) 
command 

 

Models link 
ON/OFF 

Center view 

Grid ON/OFF Snap to grid 
ON/OFF 

Snap to points 
ON/OFF 

Zoom window 

Zoom out Zoom in Rotate X clockwise Rotate X 
counterclockwise 

Front cut plane 
forward 

Front cut plane back Rotate Y clockwise Rotate Y 
counterclockwise 

Camera out Camera in Rotate Z clockwise Rotate Z 
counterclockwise 

View modifications may be done also with the mouse wheel: 

1. top, bottom, left and right view movements permits to scroll the 3D view; 
2. pressing the ⌥(option) key at the horizontal mouse-wheel moving the software will react with an 

horizontal view rotation (pitch), and to a vertical mouse-wheel moving a vertical view rotation 
(yaw) will be linked. 

3. pressing the ⌘(command) key the mouse-wheel moving will be linked to a video-plan view 
rotation (roll); 

4. pressing the ⇧(shift) key vertical mouse-wheel movements will be linked to the zoom (Zoom in and 
out), while horizontal mouse-wheel movement will be linked to the eye position (Camera in and 
out). 

3.3.1.1. Selection management 
The user enters the selection mode. The command stops every other active command and stands by for 
another selection set to be created. 

Multiple selections proceed holding down the key ⇧(shift key) and selecting or deselecting the desired 
element: if this is overlapped with others, the user will be able to make more clicks, holding down the key 
⇧(shift key), and then will be selected, in order, from the first to the last of the overlapped elements and 
then all together. 

Multiple selection may be done by the 'window selection' simply dragging a rectangle with the mouse that 
has to totally include the elements we want in the selection. 

 
An option for making a multiple selection is the 'crossing window selection' that consists in creating a 
dragging mouse rectangle, that intersects the wanted objects, with ⌘(command) key pressed: 
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Selecting flat surfaces the Application shows the local X and Z ax (highlighted in green), defining the 
direction of the 'observers’: 

 

3.3.2. Plan view mode 

In the Plan view mode the drawer contains two group of check box (see right 
image): 

The first group permits to enumerate the elements contained in the view, the others 
permit: 

• to draw the plan view in black and white (check box 'Black and White'); 
• to project selected elements in the opposite side of the first-selected face 

(check box 'Other side View'); 
• to rotate 90° the plan view (check box 'Rotated View'). 

 

 

 

3.3.3. Result view mode 

The characteristics of this mode are explained in the Command: RESULTS paragraph. 

 

3.4. Scene Kit window 
Selecting the menu 'Rendering' Scene Kit window for the active document will be opened: this has a 
drawer that permit to manage some parameters, following the next table (see right image): 

• Background color can be chosen; 
• Model linked turn on the visualization of 3D-model linked to sources; 
• Grid make visible a reference grid on the XY plan; 
• Fog box permits to add opacity to the scene, to make it more realistic, (see 4.7.4.1 Color 

Mapping): 
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• Map results permits to map the calculation results: this option may be onerous 
for complex projects, and we suggest to flag it only when the user has chosen 
the view; 

• Saturation permits to set the maximum lux value mapped in the scene; 
• Threshold permits to set the lux value below which the color will be mapped 

following the next field choice... 
• Threshold color (see upward); 
• False color rendering permits to examine the lighting, choosing a Spectrum of 

color scale and a Luminance Filter (see 4.7.4.1 Color Mapping); 
• Ambient light permits to calibrate the global brightness of the scene; 
• Saved views permits: 

o to create a new view (button add); 
o to delete views (it is not possible to delete the first, button delete); 
o to bring as active a previously saved view (button set); 
o to rename existing view, editing it directly in the table. 

• Inside the scene it is possible to select and hide elements through a contextual 
menu that will be presented clicking on them: 

o Hide this permits to hide the selected element; 
o Show all permits to make visible all the elements make hidden with 

previous commands. 

Navigation inside the SceneKit window is simple and proceed through the method of 
the 'Virtual sphere' using the mouse and the modification keys. To rotate use the 
procedures procedures described below. 

Translation will be done with the ⇧(shift) key pressed and the zoom will be activated 
with the ⌥(alt) key pressed during the click-drag mouse procedure (using the trackpad 
it will be possible to zoom also with the 'open/close fingers' gesture). 

Finally, 6 buttons are presented, to rotate the view around X, Y and Z model axes: step interval follows 
the value saved for the main view rotations step (see §4.6.2.2 3D Space section). 
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3.5. User surfaces 
An user plane is a transparent virtual surface, that retains data relative to rays passing through it; 
measured points are placed in the barycenter of the finite elements of the same surface (defined by the 
calculation internal grids), and the local X-axis represents the viewing direction. 
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4. Guide 

4.1. Menu Room Lighting Calc 

4.1.1. Command PREFERENCES... 

 
With this dialogue in the 'General' tab it is possible: 

• to work with the preferred units: metric (cm, m) or imperial (ft., in) 
• with 'Confirm events', to disable confirm warning events like 'Are you sure to delete…'; 
• with 'Copy using minimal data', to copy only lux values in the result view while opening a mouse 

region (not applicable for roads – see 4.7.2 Command: RESULTS); 
• 'Dimension in specific layer' permits to force the dimension creation on their specific layer; 
• to define the text height for the dxf exportations; 
• to set the line thickness for the photometric curves plot; 
• to choose the default notification sound. 

In the 'Update' tab it is possible to choose to be notified for new releases: 

 

4.1.2. Command QUIT 

From this menu it is possible to exit the Application. 
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4.2. Menu File 

4.2.1. Command OPEN... 

This command permits to open an already-saved RoomLightingCalc file through the standard Mac dialog. 

It is also possible to open RoomLightingCalc projects through Drag & Drop procedures. 

4.2.2. Command OPEN RECENT 

This menu presents a list of the last opened files, and it is possible quickly open one of it. 

4.2.2.1. Command CLEAR MENU 
This command clears the list of the recent opened files. 

4.2.3. Command ROOM WIZARD... 

The Room-wizard dialog will be presented (see 3 Workspace). 

4.2.4. Command: SOURCE LIBRARIES MANAGER 

The main window is divided into 4 sections: 

• Photometry: permits to navigate and modify the photometric solid 
• Catalogue: permits to manage catalogue on disk 
• Fixture: permits to modify geometrical, electrical,... characteristic of the fixture 
• Lamp: permits to view/select lamps 
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4.2.4.1. Photometry section 
The view presents the 18 azimuthal sections of the photometry in candle for 1000 lumen with different 
colors for each curve or the I-table, according to the 'View' pop-up menu. Many options are possible: 

• With the pop-up 'Operations' it is possible to modify the active photometry, and in particular it is 
possible on a single or multiple selection (after all these procedure, to maintain the modified 
photometry it is necessary to save it with the item 'Save Fixture' in the 'Fixture' section): 

o to correct efficiency of the selected luminaires: permits to evaluate the ratio between the 
luminaire emitted flux and the total installed one: the user can scale the photometry to 
balance this value on a more correct one, following the side dialog; value can be entered 
also as a series of simple operation (without parenthesis or precedence order) like 
'100*45,12/36'. 

o to rotate the azimuth of the whole photometry at 10° or 90° steps, clockwise or counter-
clockwise, for example to overlap the C=0 axis of the imported photometry with the 
frontal axis of the RoomLightingCalc source, if the first does not respect the CIE-standard 
(this is possible importing IESNA formats); 

o to rotate the zenith of the whole photometry at 90° steps, up and down; 
o to mirror the left side of the photometry to the right side and vice-versa, respect to the 

C=0-180°; 
o to reassign the photometry as the average of the left side and the right side, respect to the 

C=0-180°; 
o to reassign the photometry as the average respect of the vertical axis and rotating it 90° 

in the azimuth; 
o to sum the selected photometries (only multiple selection). 

• Through the pop-up menu 'Plot' it is possible to choose the section or combination of sections to 
show; 

• The edit field 'Full scale' assign the diagram Y scale ratio: a 0 value let the software to choose the 
best value; 

• The pop-up menu 'View' permits to display the photometry as polar, Cartesian, I-table or 3D  
view. 
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In the I-table view mode the user can modifying a single value by editing the relative field in the list: the 
Application will answer requiring an interval (called “elastic interval”) to smooth the final result following 
a sine/cosine surface interpolation: 

 
In the 3D view navigation is possible through the standard Mac mode: 

• click + drag = rotate; 
• right-click + drag = pan; 
• alt + click + drag = zoom. 

4.2.4.2. Catalogue section 
This section presents the active source catalogue and a list of its enclosed luminaries alphabetically 
ordered: choosing a luminaire, the element identifier will be pasted in the relative edit field that make 
possible to change its name. It is possible to make multiple continuous (⇧-shift key pressed) or discontinue 
(⌘-command key pressed) selection for particular modification to the selection set. 

Furthermore it is possible to order the list of fixtures alphabetically by clicking the column title. In this 
section it is possible: 

• to add a luminaire copied from the selected ones (button '+' and also available as contextual 
menu); the program asks for sizing flux and power of the new fixture to a new value of total 
power, according to the following dialogue:  

 
• to delete the selected luminaires (button '-' and also available as contextual menu); 
• to create a new empty Catalogue; 
• to open an existing one: the active one is highlighted in the field under-center the source list; 
• to merge an existing one into the active catalogue; 
• to import a single photometry, saved in EULUMDAT, IES or TM14 format (see 4.2.4.2.1 Importing 

photometries); 
• to import a whole photometry folder included all subfolders, saved in EULUMDAT, IES or TM14 

format: in this case the software asks for some options: it is possible to rotate each photometry at 
10° step clockwise or counterclockwise, to include in the RoomLightingCalc identifier: 

o label the file name, data bank, version and format; 
o the Company luminaire catalog number; 
o the Company luminaire name; 
o to import all the bulbs with which the luminaire is powered (only EULUMDAT format) 

following the dialogue: 
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• to save the current catalogue; 
• to save a copy of the current catalogue; 
• to link a price file to the active catalogue, simply choosing it through the standard Macintosh 

dialogue: the linked one is highlighted under-left the source list; 
• to unlink any price file from the active sources catalogue; 
• to export all the luminaires in the active catalogue as a simple list of sources in plain text format 

with tab delimiters, formatted as 'Model' - 'Input flux' (Lamps number x Lamp flux) - 'Output flux' 
(Luminaire outgoing flux) - 'Efficiency %' (Light Output Ratio); 

• to export the selected luminaries as: 
1. IES-NA photometry file, and it is possible to personalize some fields as in the next figure: 

 
2. EULUMDAT photometry file; 
3. PDF drawing file; 
4. PDF protocol that may include: 

o the longitudinal section (C=0/180) of the luminary’s photometry; 
o the longitudinal (C=0/180) and the transversal (C=90/270) section of the luminary’s 

photometry; 
o all the sections of the luminary’s photometry; 
o all the numeric fields defining the photometry (I-table); 
o the luminary’s picture. 

 
5. Collada (DAE) 3D file (if the 3D view is activated in the 'View' pop-menu); 

• to find lighting sources that contain a specific text inside the model name or to replace all the 
occurrences of a certain text string in the selected sources (once activated the 'Replace' field 
through the toggle menu inside the 'Find' edit field); moreover, typing '#' followed by a number N 
the application will cut from the name the first N characters; 

• to copy in a single text string the code and the model of the selected source (also available as 
contextual menu); 
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• to copy the selected photometries in the Brotens native format for pasting them in another 
catalogue; 

• to paste the previously copied photometries in the active catalogue; 
• to copy the active photometry in PDF format; 
• to copy the active photometry in PNG format. 

4.2.4.2.1. Importing photometries 
RoomLightingCalc permits to import photometric data from IES-NA, EULUMDAT, TM14, PDF or DXF files. 

The user will be prompted with the following dialogue, to save the photometry rotating it at 10° steps, 
clockwise or counter-clockwise, with an identifier containing or not: 

• the file name, data bank, version and format; 
• the Company luminaire catalog number; 
• the Company luminaire name 

...and to import all the bulbs with which the luminaire is powered (EULUNDAT format): 

 
For text files, RoomLightingCalc will try for the first time the IES-LM-63 format (to format a file in such a 
way see Appendix C: IES-NA data interchange format). If this is not a correct filter, the Application reply 
with an alert and try EULUMDAT filter (to format a file in such a way see 6.4 Appendix D: EULUMDAT 
data interchange format) and finally the TM-14 filter will be tried. 

If the luminaire to import has the possibility to install different bulbs (EULUMDAT formats), the Application 
will display a dialog for choosing the configuration to present. 

RoomLightingCalc can import also PDF or DXF drawing as photometry, that must contain the following 
information: 

• a couple of lines drawn in BLACK crossing in the center of the real photometry if drawing a polar 
diagram or an horizontal black line and (optional) a YELLOW line perpendicular in the middle 
point of the first if drawing a Cartesian diagram; 

• a text object indicating the maximum intensity value (optional); 
• a polyline or some connected lines drawn in RED (or a mainly-red color – ex.: RGB={0.8, 0.1, 

0.2}) defining the C=0, C=180 sections and containing the center of photometry; 
• a polyline or some connected lines drawn in BLUE (or a mainly blue color – ex.: RGB={0.2, 0.1, 

0.8}) defining the C=90, C=270 sections and containing the center of photometry (optional but 
the first to use if the red one is present); 

• a polyline or some connected lines drawn in MAGENTA (or a mainly magenta color – ex.: 
RGB={0.8, 0.7, 0.1}) defining the C=60, C=240 sections and containing the center of photometry 
(optional but the first to use if the red and blue ones are present); 

• a polyline or some connected lines drawn in CYAN (or a mainly cyan color – ex.: RGB={0.2, 
0.7, 0.8}) defining the C= 10, C=190 sections and containing the center of photometry (optional 
but the first to use if the red, blue and magenta ones are present). 

• a polyline or some connected lines drawn in GREEN (or a mainly green color – ex.: RGB={0.2, 
0.7, 0.2}) defining the C=30, C=210 sections and containing the center of photometry (optional 
but possible to use only if the other colors are present); 
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Opening the DXF file, if not present in the file, the Application asks for the maximum intensity in the 
selected photometry, to bring the drawing to the real scale. Photometry to import may be drawn as polar 
or Cartesian diagram, following the next indications: 

Drawing a polar representation Drawing a Cartesian representation 

 
 

4.2.4.3. Fixture section 
In this section it is possible: 

• to save the modified luminaire ('Save fixture' button). The label inserted in the edit field may 
contain some code characters: 

o a couple of round brackets with a fraction '(1/N)': this case means for the software, in the 
evaluation exportation, that the fixture is a part of a bigger luminaire composed by N 
identical parts (es. 'fixture AAA (1/3)'); in the price list the cost of the fixture has to be 
divided by N and finally in the computation it will be reassembled with the price brought 
to the original cost; 

o some text included in square brackets '[...]' will be omitted in the report. This opportunity 
is useful to connect luminous parts (saved as photometries) of the same fixture: the part of 
the label external to the brackets '[...]' has to be the same, while inside the brackets the 
part may be evidenced, taking care to highlight with a '+' sign all the secondary parts (es. 
'fixture AAA[part 1]', 'fixture AAA[+part 2]', ...). 

• to assign dimensions and luminous volume. Luminaire geometry is defined through its “Bounding 
box” (needed for shadow calculation) and its “Luminous box”, both described as box oriented in 
the Local Coordinate System of the lighting source as in figure: 

 
• Because of the local X-axis in RoomLightingCalc is the C=0° axis, for compatibility with the 

interchange formats it is present the “x <-> y” button, that permits to invert the fixture dimensions 
along the local axis; 

• to assign total power (that take count of electronic parts and of what the luminaire needs to 
function; it is possible to input this field as an absolute value, es. '120', or as a percentage of the 
lamps power, es. '20%') and maintenance factor (must be choose on low values 30%÷50% for 
dusty luminaries and/or rooms, and on better values 70%÷90% for new luminaries and/or clean 
rooms); 

• to assign the total flux of the fixture, that take account of the Light Output Ratio of the Luminaire; 
• to assign blind height and antiglare grids; 
• to control emitted flux, and in particular: 
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o efficiency; 
o 0°-30° emitted flux; 
o 0°-40° emitted flux; 
o 0°-60° emitted flux; 
o 0°-90° emitted flux (DLOR = downward luminaire output ratio); 
o 90°-120° emitted flux; 
o 90°-130° emitted flux; 
o 90°-150° emitted flux; 
o 90°-180° emitted flux (ULOR = upward luminaire output ratio); 
o 0°-180° emitted flux (total). 

• to control equivalent light-cone (those angles in which the intensity decay at 50% of the one 
measured at gamma=0°) ; 

• to control the CIE class (the official CIE classification for the fixture) end Intensity Class D and G; 
• to force the assignment at Intensity Class D.0 through the check box (if the bulb or its image is 

visible from an angle of 85° from the vertical, according to the D.0 definition); 
• to link/unlink an image to the fixture, that has to be contained in the 'Picture' folder inside the 

'Luminaires' folder (choosing 'Cancel' the user can delete every link to the element); 
• to link/unlink a 3D dxf-model to the fixture, that has to be contained in the 'Models' folder inside 

the 'Luminaires' folder (it is important that the model will have origin O and spatial orientation 
equal to the RoomLightingCalc scheme to have a correct visualization inside SceneKit and with the 
convention that all the dxf-elements drawn in color #0 represent the luminous parts of the fixture, 
and in RoomLightingCalc will be drawn in the source color); 

The '>' button, if present, permits to automatically assign the actual value to all the selected elements in 
the source list of the active Catalog. 

4.2.4.4. Bulb section 
Bulbs installed in the lighting source will be characterized with the following parameters: 

• type of emission spectrum; 
• number of installed ones; 
• power of the single bulb in Watt; 
• conventional bulb name; 
• lamp holder type; 
• luminous flux of the single bulb in Lumen; 
• correlated Color Temperature and RGB color. 

It is possible to change the proposed Color Temperature simply editing the new value in its field or clicking 
right side coloured button. 

The main dialogue presents, finally, a list reporting some of the most common commercial lamps, for a 
quick selection through a double click. 

The '>' button, if present, permits to automatically assign the actual value to all the selected elements in 
the source list of the active Catalog. 

The bulb database is contained in the "Lamps.txt" file is a simple text file that can be edited with whatever 
software but saved as text file. 

The file has the following structure: 

class NBS W Lm K Holder Company Identifier x y ∆uv Type 

T5 35 3650 4000 G5 - T5 tube . 3855 . 44017 . 02559 FLIN 

...           

The first line is the header; follow the real lamp records, one each row. 
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Each field in a record is separated by a 'tab' code. 

  



  Guide 

User Guide © 2014-2018 24 Marcello Brocato and Ecleti - Roberto Panetta 

The user has to introduce a new lamp at the correct row, following the last field 'Type' in which: 

Identifier description   Identifier description  

FCOM compact fluorescent   NAHP sodium high pressure  

FLIN linear fluorescent   NABP  sodium low pressure 

HALO halogen   INCA incandescent  

HGVA mercury vapor   LED_  led  

JMET  metal halide  XENO xenon 

The operation is to insert a new record as a row inside the correct lamp group, then each field of the 
record has to be filled: 

class NBS  standard lamp name;  

W  nominal power consumption  

Lumen nominal lumen output  

K Kelvin color temperature of the source  

Holder  lampholder 

Company  Company 

Identifier  Commercial name 

x x-coordinate (CIE 1931)  

y  y-coordinate (CIE 1931) 

∆uv distance from the Black Body curve in the CIE 1960 diagram  

TYPE internal identifier for the lamp type (one of the name in the previous table) 

Once finished, the user has to save the file as text file with the name "Lamps.txt" in the same directory of 
the original one. 

4.2.5. Command: SERVICE FOLDERS... 

This command permits to manage the Application service folders. The first time the Application runs the 
user is prompted for locating these folders: 

 
Once chosen, the Application initialize it. It is possible to reset the service folders in every moment simply 
choosing this menu and pressing the 'Reset Library Folder...' button: 
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...or navigating inside it through the button 'Open Library Folder'. 

4.2.6. Command: CLOSE 

This command permits to close the current project. 

4.2.7. Command: SAVE 

This command permits to save the current project. 

4.2.8. Command: DUPLICATE 

This command permits to duplicate the current project. 

4.2.9. Command: RENAME 

This command permits to rename the current project. 

4.2.10. Command: MOVE TO... 

This command permits to move to another folder the current project. 

4.2.11. Command: REVERT TO... 

This command permits to recall the last saved versions. 

4.2.12. Command: EXPORT 

This command allows the saving of work in different formats for compatibility with other programs of CAD, 
graphics, text, database, etc... The possibility to exchange information with other applications has the 
purpose to permit the maximum action freedom for the user in compiling drafts and technical reports, 
showing the results of the calculations. Available export formats follow. 

4.2.12.1. Export TEXT, RTF format 
The Application will create a complete calculation report with which it is possible to read numeric results 
and chromatic and spatial coordinates of all the elements in the project. 

If the user has made a selection set, the Application will export information and results only for the 
selected elements; in the other case the whole project will be registered. If TEXT was selected, the 
Application will export a TEXT file with tabulation, while for RTF/RTFX (Rich Text Format) export the 
Application will use a template (one fore each currency and/or customer) created ad formatted by the 
user. In the example-file are present every styles needed for a correct printing of the report, and the user 
will be able to change them, leaving the number of tabulations and, if possible, the width of the fields. 

 

In the RTF templates, it is possible to insert some automatic information through some codes (case is 
relevant): 
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• #1 = The image saved in the slot 'Cover Design'; 
• #A = Agent name; 
• #D = Actual date; 
• #h = Actual time; 
• #N = File name (complete directory); 
• #C = Customer name; 
• #R = Reference and place; 

Fields to include in the exportation are selectable by the following dialog: 

 
The other saved drawing slots, 'Layout design' and 'Result Design' will be inserted in their opportune 
places inside the report. 

Buttons refer to the following dates: 

• (List of) Flat Surfaces: 

Number, Level, Type of surface, Area, Color of the upper/lower side (number, name, reflection 
coefficient), Calculation grid; 

• (List of) Openings: 

Number, Owner Type, Owner Number, Total glass thickness, Extinction coefficient, Color (number, name, 
transparency coefficient); 

• (List of )Lighting Sources: 

Number/Reference to the model, Model, Total power and flux with dimming percentage, Number of 
Lamps, Lamp type, Lamp label, Lamp socket, Lamp power, Lamp luminous flux, Lamp color, Total installed 
power, Maintenance factor, X/Y position, Installation height, Pointing (x, y, z/azimuth, zenith); if this field 
is checked will export in the report the last viewed image in the “Project Source” session. If Detailed is 
active also: Catalogue, Level, anti-glare shader height, anti-glare shader angles, anti-glare grid height, 
anti-glare grid x,y dimensions. If Photometries is active also photometric diagrams with the curves visibility 
selected in the relative pop-menu 

• (List of) Objects: 

Number, Level, Type of surface, Color of the upper/lower side (number, name, reflection coefficient), 
Large Grid [cm], Calculation grid or number of X-Y divisions if a mesh; 



  Guide 

User Guide © 2014-2018 27 Marcello Brocato and Ecleti - Roberto Panetta 

• (List of) Lines: 

Number, Level, Total length, Color number (group), Thickness; 

• (List of) Polylines: 

Number, Level, Total length, Color number (group), Thickness; 

• (List of) Cameras: 

Number, Position; 

• Daylight Data: 

Place, Latitude [°,’], Day, Month, Hour, Direct Radiation [W/m2], Diffuse Radiation [W/m2], Albedo 
[%]; 

• Titles from Level 2: 

Start title indentation from level 2; 

• Quality parameters: 

For each user surface: Number, Minimum horizontal illuminance, Maximum, Mean, Minimum/Mean 
illuminance ratio, Minimum/Maximum illuminance ratio, Mean/Maximum illuminance ratio; if this field is 
checked the Application will export in the report the last viewed image in the “Results” session; 

• Number of quality fields: 

The Application will prepare the number of quality fields relative to some surfaces the user want to insert 
in the report; 

• Plan detailed info: (for the roads) 

Road width, sources layout type, sources inter-distance, sources height, source beam, source beam tilt 
angle, luminaire label, bulb type; 

• Road Classification EN13201: 

Tables contained in the EN13201; 

• Computation: 

Prizes for each fixture and each special piece, in the currency exportable to the estimation, are saved in 
the same folder of the source catalog (ex.: “Fixtures”) in a text file with the same name of the catalog and 
the “.prz” extension (ex.:”Fixtures.prz”). This file must contain the same list of lighting sources as in the 
Application catalog, and will be filled by the following fields, separated by tabulations: 

o element description (it must be the same character string with which the Application 
recognize the element – to export in text format these identifying strings for a whole 
catalog, see 4.2.4 Command: SOURCE LIBRARIES MANAGER 

o price in the first currency (ex.: “English” -> £) 
o price in the second currency (ex.: “Italian” -> €) 
o price in the third currency (ex.: “German” -> €) 
o … 

 

Description  currency 1 currency 2  currency 3  ....  currency n  

Fixture #1 10.6 8.44  100.5  ...  128.7 

Fixture #2 33.6  456.9 345.1  ...  789.0 

... ... ... ...  ...  ... 
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Fixture #m  236.9  16.8  444.8  ...  100.5  

Only viewed elements will be exported, and in particular: 

o for each line and polyline: Number, Group (color), Description, Length, Quantity, Prize, 
Total; 

o for each special piece (to select manually): Number, Image (if saved), Description, 
Quantity, Prize, Total; 

o for each installed lighting source model: Progressive number (1, 2, …) and local reference 
(A, B, …), Image (if saved), Description, Image (if saved), Description, Total power, 
Quantity, Prize (if saved), Total. 

If the option Computation as table is active it is possible to export computation as table with formulas The 
software, finally, will automatically update the 'Summary.txt' database (saved in the same folder of the 
Application) filled with the list and the summary data of the RTF, RTFX or TEXT exported projects. 

4.2.12.2. Export DXF format 
Selecting 'DXF' from the sub-menu the selected element will be saved in DXF format or, if no selection is 
present, the whole project: 

• translating lines in LINE elements; 
• faces in POLYLINE elements; 
• furniture and free objects will be 'exploded' in 3DFACE elements, each put on a layer whose 

name is that one of the starting element plus a progressive suffix (Es. starting layer = ‘Walls’ ; 
ending layer = ‘Walls#o1’ ;...); the other object type will be exported as POLYLINE mesh; 

• lighting sources will be exported in INSERT (BLOCK) elements schematized as a circle. 

In the result session, the exportation will involve numeric fields and iso-value curves, in the other case the 
user will be prompted to assign the exportation scale (from centimeters/inches to…): 

 
The 'Explode objects' check-box permits the objects exportable as poly-mesh to be 'exploded' in 3DFACE 
elements. 

4.2.12.3. Export in COLLADA format 
If the Scene Kit window is opened, selecting 'Collada (3D scene)' from the sub-menu a .dae object 
containing the actual scene will be saved. 

 

If the user doesn’t want to export all hidden elements the relative check box has to be flagged. 

4.2.12.4. Export in JPEG format 
Selecting 'JPEG' from the sub-menu, a JPEG image clipped from the screen will be saved. 

4.2.12.5. Export in PDF format 
Selecting 'PDF' from the sub-menu, a vectorial PDF file clipped from the screen will be saved. 
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4.3. Menu Edit 

4.3.1. Command: UNDO 

Permits to revert the last command. This permits to come back in the command sequence. 

4.3.2. Command: REDO 

Permits to discard the effects of the “Undo” command, going on one step in the command sequence. 

4.3.3. Command: CUT 

Works only in the selected edit field, in the standard Macintosh mode. 

4.3.4. Command: COPY 

 The procedure is different if an edit field is selected or not: 

• If an edit-field is selected the command works in the standard Macintosh mode; 
• If the view is selected its content will be inserted into the clipboard in PDF: this allows to transfer 

information between RoomLightingCalc and the other programs. 

If an edit-field is selected the command works in the standard Macintosh mode. 

4.3.5. Command: PASTE 

Works only in the selected edit field, in the standard Macintosh mode. 

4.4. Menu Options 

4.4.1. Command: HIGH RESOLUTION 

The command permits the regeneration of the whole project alternatively with large and small grids for 
every element. The "High Resolution" mode is highlighted in the menu item. The Application informs, 
before to confirm the operation, that may be onerous in terms of calculation timing. 

4.4.2. Command: REMOVE UNUSED POINTS 

The Application executes an internal database check, deleting redundant information and entities. 

4.5. Menu Layers 
From this menu the user can show/hide or make active layers (virtual spaces in which elements are 
drawn). Layers are a powerful working tool, because they can simplify the scene, temporarily hiding 
unimportant parts, deleting whole groups of objects and allowing the user to include or exclude from the 
calculation other objects. 

To make a layer the active one simply select it in the menu list, while to show or hide a single layer the 
user has to select the item while holding down the ⌥(option) key. 

4.5.1. Command: SETTINGS... 

Permits to manage layers: 
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It is possible: 

• to add a new layer (button ); 
• to delete selected layers (button ): the user will be prompted to delete all the elements 

contained in these layers; 
• to bring layer upward in the list (button ); 
• to bring layer downward in the list (button ); 
• to show the selected layers (button ): the layer will be flagged with a '-' sign; 
• to hide the selected layers (button ): the layer will be unflagged; 
• to make the active one the selected layer (button ): the layer will be flagged with a '√' sign; 
• to select all layers whose name contains the text edited in the search field. 

4.6. Menu View 

4.6.1. Command: RENDERING 

Will be opened a new window for the current document in SceneKit mode: the way to navigate within the 
model is different than the 'normal' mode, and it is called the 'virtual sphere' mode. 

The alternate selection of the command marks with '√' and unmark the item. 

For the management of this window refer to 3.4 Scene Kit window. 

4.6.2. Command: VIEW SETTINGS... 

The command opens a dialogue that allows the user to modify some parameters of the active document 
and eventually saving them as default (button 'Default for new documents): it is divided into four tabs:. 

4.6.2.1. Visualization section 
The section permits to manage some general parameter of the document: 
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• to view the scene in black and white mode or in black-red-white mode; 
• to select the text height in the screen; 
• to select the background color; 
• to work in auto-snap to known points in creating or modifying element sessions; 
• to show the line barycenter, for an easy snap to them; to project in 2D view also the shut-off 

lighting sources; 
• to show the finite-element frames in the 2D views; 
• to enumerate elements, points,... 
• to choose the thickness of the line with which RoomLightingCalc renders the scene; 
• to define the virtual grid color, divisions, limits and visualization. 

4.6.2.2. 3D Space section 

The section permits the setting of the tridimensional visualization parameters: 
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• values and steps for every movement of the view (rotations, zoom, camera, scroll); 
• switch between assonometric /perspective view. 
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4.6.2.3. Sources symmetry section 
This section permits to manage sources symmetry options: 

 
and in particular: 

• Nines field are present, that permits to translate in an independent way the X-symmetrized 
sources, the Y-symmetrized source and the XY-symmetrized ones; 

the 'Rotational symmetry' is useful to force the y-axis rotation (better configuration for road project) in the 
symmetric source option: its flag handle the scene according the following scheme (see 0   
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• Sources symmetry section): 

X-X and Y-Y standard symmetry: X-X and Y-Y "rotational" symmetry: 
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4.6.2.4. Info 
The section permits to assign the general info for the document: 

 

4.6.3. Command: PLAN VIEW 

This command allows you to project all selected elements in the Local Coordinate System of the first-
selected element (flat surface or object). In a quoted plan view will be visible on the 1st selected element 
L.C.S., for the each selected elements: 

• for each flat surface: its planar projection; 
• for each object: its planar projection; 
• for each lighting source: its progressive number, a letter for model reference and the pointing 

vector; 
• for each line and polyline: its progressive number and a number for color/group reference; 
• for each camera: its position. 

The alternate selection of the command marks with "√" and unmark the item. 

4.6.4. Command: OTHER SIDE VIEW 

Only in 2D view, permits to invert the side of the 2D projection: this means the back-side of the flat surface 
and the 'internal' side of the object. 

The alternate selection of the command marks with “√” and unmark the item. 

4.6.5. Command: ROTATED VIEW 

Only in 2D view, permits to rotate of the 2D projection. 

The alternate selection of the command marks with “√” and unmark the item. 
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4.6.6. Command: BLACK & WHITE 

Permits to switch from a color representation to a black and white (or black, red and white, following the 
relative Preference in the dialog setting) one and vice-versa. This selection checks with a “√” or uncheck 
the menu. 

4.6.7. Command: ZOOM IN 

The command executes one-step zoom in; the step is fixed in the '3D Space section' dialog, at the item 
'steps' as the button 'Zoom in' of the 'View' palette does. 

4.6.8. Command: ZOOM OUT 

The command executes one-step zoom out; the step is fixed in the '3D Space section' dialog, at the item 
'steps', at the item 'steps' as the button 'Zoom out' of the 'View' palette does. 

4.6.9. Command: ZOOM WINDOW 

Through the procedure click-click it is possible to create a rectangle that will point to the area to zoom in, 
as happens with the button 'Zoom window'. 

4.6.10. Command: CENTER VIEW 

Is useful to center the view, as happens with the button 'Center View'. 

4.6.11. Command: ZOOM SCALE 

This menu permits to bring the actual plan view to one of the selectable values. 

4.6.12. Sub-Menu: VIEWS 

4.6.12.1. Command SETTINGS 
Trough these command the Application enters the view manager: 

 
The dialogue permits: 

• to create a new view (button ); 
• to delete some previously saved view (it is not possible to delete the first seven ones, button ) ; 
• to rename existing view, editing it directly in the table. 
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The dialogue presents the name of every saved view in the last part of the list, and it is possible to make 
one of them active simply choosing it in the list. 

4.6.12.2. Other Command 
It is possible to select directly some predefined views (Top, South, West, Bottom, North, East) or others 
previously saved. Selecting one of the saved view through its menus with the ⌥(option) key pressed 
permits to reassign the active view to the saved one. 

4.6.12.3. Command: SAVE IMAGE FOR... 
Permits to save the actual scene for the three types of view: 

• Cover Design (3D scene) 
• Layout design (2D projection scene) 
• Result Design (examine result scene) 

...to export in the eventual rtf report (see 4.2.12.1 Export TEXT, RTF format). 

4.6.12.4. Command: COPY VIEW 
The command permits to save the perspective view parameters (scene rotation, point of view placement, 
zoom and frontal section) for a following operation of view restoring through the command “Paste view”. 

4.6.12.5. Command: PASTE VIEW 
The command permits to restore the perspective view parameters (scene rotation, point of view 
placement, zoom and frontal section) previously saved through the command “Copy view”. 

4.7. Menu Lighting 
This section includes the necessary operations for lighting calculation and for the analysis of results. The 
analysis will be available only for the visible objects on the screen; in other words, there will be excluded 
from calculation those elements belonging to hidden layers. 

4.7.1. Command: CALCUL 

The Application shows a dialog: when the calculation has been started for the first time, it is possible to 
choose sources to include and some other useful parameters for a right analysis. 

There are two different possibilities: if it is the first time that the calculation goes on (left side dialog) or if 
the procedure has been initialized (right side dialog): 

  
The Application gives information on the state of the calculation procedure (computed only Direct, nth 
multiple reflection, ...). 

For still not initialized calculation, the Application asks what to include, and in particular sources at low, 
medium or high precision: artificial lighting sources will be computed. The precision in calculation involves 
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the volumetric schematization adopted for the sources: low = point light, medium = steps of 40 cm 
distributed luminance, high = steps of 20 cm distributed luminance. 

Calculation will go on, moreover, for the number of total reflections given in the edit field 'Reflection 
number'. For example, to initiate the calculation with direct only '0' must be keyed to initiate the 
calculation with the direct and one multiple reflection 1 or more must be keyed. After the direct 
calculation, inside every group of multiple reflection the user ask to execute, to accelerate them (against 
some precision loss), it is possible to set a 'Minimum luminance' threshold, below which the relative source-
finite element will not be considered. To have an idea of the number of finite elements that will be 
excluded changing this threshold, it is possible to enter, through the button 'Analyze', a dialogue in which 
these control parameters are presented. 

Following graphics reporting the number of elements involved (x-axis) in calculation in function of a 
luminance threshold in the first and in the third multiple reflection. 

  
Once the calculation started, the following the dialog: ... 

 
permits to break it by clicking the 'Stop' button or by typing 
the 'esc' key: after the user reply to confirm breaking the 
calculation... 

 
the Application stops it. To start again from the direct, in 
whatever step of calculation, it is possible to check the 'Return 
to direct calculation' box. Finally with the 'Calculation without 
shadows' check box the user is allowed to execute very fast 
calculation, but without computing shadows: turning on this 
feature may bring to high approximations, so a reasonable 
use is suggested. 

4.7.2. Command: RESULTS 

After selecting only one element, this command lets you enter 
a section for calculation testing. The drawer changes the 
layout: it is divided into two tabs, as shown on the right. 
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The 'Setting' tab permits to assign parameters, while the 'Results' tab permits to examine and edit the 
results (an example is presented). For the explanation of the available options see 0   
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Command: RESULT SETTINGS. 

In the main view the user may open a 'zone' with a mouse 
click-drag-release procedure: 

 

 
 

Once the area (in the figure, the red rectangle) is drawn a list of values appear in the drawer at the 
'results' tab, reporting the illuminaments, uniformities, luminances,... of the selected zone: the user can 
copy them. This will take place in different ways, depending on the type of the chosen element: if this is a 
flat surface, it is possible to select also other elements to project on the plan of the surface. At this point 
the clipboard will be automatically filled with the presented text results, in a minimal format if the user 
selected this option in the Preferences. 

Results may be examined in color mapping, in iso-value curves, in numeric values or in mixed mode. 

Inside this section, unusable menus, rotation and camera buttons and section scroll bar will be hidden. 

A unique case is the U.G.R. plot choice: 

• selecting the curve mapping (see the side image) the application will present a star-shaped plot in 
which each segment is proportional to the U.G.R. value in that direction (from the local x-axis at 
45° steps). Furthermore, the value of the maximum and a circle representing the average U.G.R. 
in that point are plotted; 

• selecting the value mapping the average U.G.R. in that point will be plotted. 

 

To examine the other side of the surface it is necessary to select from the 'Settings' tab or through the 
dialogue in the 'Lighting'->'Settings' menu the item 'Other side view' check-box. 

In the same way, for the visualization in finite elements we have to select from the 'Frame mesh' check-
box. 

From the 'File'->'Export' menu it will be possible to save the results, for the visible side of the surface, in a 
file: 

• JPEG (bitmapped) for color visualization; 
• PDF (vectorial) for curves and numeric fields mapping; 
• DXF 2D for curves and numeric fields mapping. 

From the 'Edit'->'Copy' menu the result for the visible side of the surface will be transferred to the 
clipboard. 
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4.7.2.1. Selecting Furniture 
The Application replies with no results. 

4.7.2.2. Selecting a Flat Surface 
The Application presents a projection orthogonal to the plan of the surface. Creating on video a 
rectangular region (click-drag-release mouse operation) it is possible to select those finite elements of the 
surface also partially belonging to the region. For these elements, the Application presents an analysis of 
the result in the status line. 

4.7.2.3. Selecting an Object 
The Application presents a central-type projection eventually with unified radius for the object. Creating 
on video rectangular region (click-drag-release mouse operation) it is possible to select those finite 
elements of the surface belonging to the region. For these elements, the Application presents an analysis 
of the result in the status line. 

4.7.3. Command: OTHER SIDE 

Active only in the result analysis mode, it permits to show the back-side of the surface. The mark “√” in the 
menu advises that the user look at the back-side of the element. 
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4.7.4. Command: RESULT SETTINGS 

With RoomLightingCalc it is possible to examine 
results in very many ways, available both on 
video and in the bitmapped, numeric or vectorial 
exportation. 

It is possible to obtain information, depending 
from the type of the selected element, on: 

• horizontal illum.: horizontal illuminance in 
lux (for “horizontal” we mean “normal to 
the surface”); 

• semi-cylindrical illum.: Semi-cylindrical 
illuminance (parallel to the surface, 
direction of the local X-axis direction - only 
user surfaces); 

• hemispherical illum.: Hemispherical 
illuminance (parallel to the surface - only 
road surfaces); 

• vertical X+, Y+, X-, Y- light.: four Vertical 
illuminance in lux (for “vertical” we mean 
“parallel to the surface, in the direction of 
the local X-axis and Y-axis, positive and negative sides” - only user surfaces); 

• camera 1 light: the illuminament in the camera 1 direction (only user surfaces); 
• Luminance: luminance in cd/m2 (only not-user surfaces); 
• Luminance observer 1...6: luminance in cd/m2 or cd/ft2 in the direction of the observer 1, ... (only 

road surfaces); 
• C.R.F.: Contrast Rendering Factor (only user surfaces); 
• C.G.I.: Contrast Glare Index (only user surfaces); 
• U.G.R.: Unified Glare Ratio (only user surfaces); 
• G.R.: Glare Ratio (only user surfaces); 
• Daylight Factor: if calculation goes on only for sky radiation (only 'normal' surfaces); 
• R, G, B: RGB color components. 

The results viewed on the screen may be copied in the clipboard or exported in all available formats that 
are bitmapped, vectorial or numeric. 

The dialog is divided into three sections: the upper side is relative to the color visualization, the central 
one to iso-value curves and the lower to the numeric fields mapping. 

4.7.4.1. Color Mapping 
By selecting “Color mapping (horizontal)” button the user can examine the horizontal (on the surface) 
lighting. At 8-colors (button “False”), eventually mapping luminances (“Luminance” check-box), it is 
possible to choose the spectrum to plot results among three ones. 

 
At real-color visualization (button “True”) for the single finite elements is possible to apply to the view a 
“Filter” to simulate a luminous sensation less or more similar to the human eye sensitivity. Luminance may 
be mapped in a linear (filter “none”), quadratic (filter “2”) or fourth-root (filter “4”) way, according to 
the following scheme: 
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The following figure shows luminous sensation filters in a day lighted room: 1=none, 2=quadratic, 
3=human eye: 

   
With the value contained in the “Threshold” edit field it is possible to create an “high-pass” filter, to 
emphasize (by a color selectable from the pop-up menu “Color” near this edit field) those finite elements 
that are in a lower lighting condition then the fixed threshold. 

In this mode the chromatic effect in the video scene is “proportional” to the real effect according to an 
input value in the “Saturation” edit field. Lower saturation values make the scene lighter, higher values 
permit a better mapping on higher lighting values. With the “Max” button the Application suggests as 
saturation, the maximum lighting value found in the project. The Saturation field, finally, may be 
considered as the aperture of a camera. 

4.7.4.2. Curve mapping 
Curve mapping may be executed in the modes proposed by the Application, according to the type of the 
selected element (user surface or not) and to the type of calculation (only sky diffuse radiation or other). 

The “Curve color” pop-up menu permits to choose the color for the curves to plot, while selecting "Colour 
scale" every curve will be plotted following the spectrum colour scale of the paragraph 4.7.4.1. The user 
can choose the first curve (field “Min.”), the last one (field “Max.”) and the number of curves to plot (field 
“Curve num.”), while it is possible to plot curves at “logarithmic intervals” checking the appropriate 
button. The “Auto range” button optimizes the plot from the minimum to the maximum value available in 
the selected element. 

The “Spline” fields permit to choose the type of interpolation for the curves to plot. 

Once cheched the "Curve Map" box for a flat surface, the user will have the actual 2D map plotted also 
in 3D: uncheck the box in the "Result Setting" dialogue to release this option. 

4.7.4.3. Values mapping 
Values mapping may be executed in the modes proposed by the Application, according to the type of the 
selected element (user surface or not) and to the type of calculation (only sky diffuse radiation or other). 
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The “Color” pop-up menu permits to choose the color for the values to plot. At the end of the dialogue 
there is the pop-up menu "Luminance" that permits to switch from the standard photopic calculation of the 
luminance to the unified (MOVE modified) one. This take count of the mesopic vision due to: 

• the luminance field L (linearly interpolated from scotopic L≤0,25 to photopic L≥3,00 cd·m-2) ; 
• the lamp type, color and power (Scotopic/Photopic lamp parameter) . 

The Unified Luminance L is calculated as follow: 

L = ëê
é

ûú
ùXP

683 + 
(1-X)S
1700  · 

683
X+0.402(1-X)  

...where 

• X is the MOVE parameter defined through the next graphic: 

 
• S and P are the Scotopic and Photopic parameters whose ratio is function of the lamp type, color 

and power: this parameter is calculated as the average of all the lamp present in the project. 

Finally, there is a field "Text Height " permits to choose the height of the text in the visualization. 
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5. Tutorials 

5.1. Rectangular room 
This tutorial permits to build a simple rectangular room and to choose an efficient lighting solution. 

5.1.1. Building the room.  

1. The first step consist in opening from the menu "File" the item "Room Wizard" that will open the 
standard dialog; let's choose the room parameters and the surface color following the scheme at 
point 1: 

 
2. Then navigate in the "Luminaires" folder to choose "DEMO.ildolib" catalogue (point 2) in which 

select the "Recessed 3000K, LED 1x36W" luminaire (point 3). 
3. In the "Lux" edit field everything is ok, press the "Create room" button and the Application will 

build the room to start calculations. 
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5.1.2. Starting calculation 

 Select in the menu "Lighting" the item "Calcul...", erase the content of the "Number of multiple reflections" 
edit field and then pushing the button "Ok"... 

 
...the software will compute the direct lighting calculation. To examine the results at this first step, select 
the user surface and choose the menu "Lighting"->"Results": 
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Zooming to a scale of 1/20 (menu "View" "Zoom scale" "1/20"), typing 500 in the "Saturation val." edit 
field and choosing "Color Map" + "Curve Map" + "Autoscale", You will see the following view: 

 
In which is presented the flat surface n.8 in true color and isolux curves. You can change the show results 
mode in some other way through the drawer settings (see menu "Lighting"->"Settings..."). 
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Opening with the mouse a rectangle inside the surface or simply making a click somewhere, the partial 
result values will be presented: opening a rectangle from the top-left corner 1 to the bottom-right one 2 of 
the projected surface, the information on the whole surface will be presented: 

 
 In the left drawer will be presented the values relative to the selected zone. Then we can go on in 
multiple reflections: choose "Lighting"->"Calcul..." from the menu: 

 
 We have the 100% of interreflection to redistribute and we can look for the best value to cut the 
reflections at the first step: choose "Analyze": 
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...and with the mouse bring the horizontal red line near the knee between 40.18 and 60.27: pressing 
"OK" the luminance threshold will be fixed. For now, it is better to do 4 multiple reflection, and put 0.5 as 
the minimum emitted intensity, as presented in the upper dialogue. Pressing "Ok" other 4 reflections will 
be done with this threshold. 

 And now, let's examine again the result: select the user surface and select the menu "Lighting" "Results". 
Open a rectangle that include the whole surface and read the results: 

 

We can go on in multiple reflections or stop calculation accepting the results. 

5.1.3. Preparing the report 

 For this, we have to choose the picture we want to show in the first page (menu "View"->"Save Image for 
Report as 'Cover design'"), in the "Installation of the fixtures" paragraph (menu "View"->"Save Image for 
Report as 'Layout design'") and in the "Result on worktop" paragraph (menu "View"->"Save Image for 
Report as 'Result design'"). 

 The procedure is simple.  
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To export the 'Result design' picture we have to select for first the surface whose results we want to 
represent and then all the elements we want to project on it: then choose the "Lighting"->"Result" menu, 
and finally select the visualization option we want to view in the report page. Follows an example: 

  
To save in the 'Result design' picture-slot select the menu command 'View'->'Save Image for Report as 
Result design'. Come back to the 3D general view by selecting "Lighting"->"Result" menu again.  

To export the 'Layout design' we have to select for first the surface we want to use as reference plan and 
then all the elements we want to project on it to create an installation layout. Follows an example in which 
the view is plotted in black+red+white (managing from the left drawer). Then choose the "View"->"Plan 
View" menu and adjust the view by centering and zooming (better in scale) it. 

  

To save in the 'Layout design' picture-slot select the menu command 'View'>'Save Image for Report as 
Layout design'. Come back to the 3D general view by selecting "View"->"Plan View" menu again. To 
export the 'Cover design' simply adjust the last 3D general view to your preferences. In the following 
picture the view is plotted in black+red+white and the 3D-model linking on.  

To save in the 'Cover design' picture-slot select the menu command 'View'->'Save Image for Report as 
Cover design'. Then select the "File"->"Export" menu and set your preferences. Pressing the "Ok" button 
the software will ask to save the report file: select the "RTF" or "RTFX" format in the pop-menu and choose 
the exportation preferences. Follows an example: 
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Then let's open the saved file to add some picture in: (follow the opened pages). 
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The first operation is to save the file in a native format.  

Then, scroll the document to see if each picture is contained in the relative page (it is possible to resize 
them) and to update fields (the table with the Product List at the end of document contains some formulas: 
it is possible to view and modify them with specific commands inside each word processor). Now we can 
paste into the document some rendered image. Come to RoomLightingCalc and, from the 3D general 
view, select the command "View"->"Rendering". You'll se something like this: 

 



  Tutorials 

User Guide © 2014-2018 55 Marcello Brocato and Ecleti - Roberto Panetta 

Put the ‘Ambient light’ at 50% and with the 'Virtual sphere' mouse-method rotate (click-drag procedure), 
zoom (mouse wheel) and drag (right-button + click-drag procedure) the view until You see something like 
the follow figure: 

 
Save the view with the ‘+’ button down in the drawer and give it a name. Turn off the ‘Grid’, activate 
‘Map results’ and uncheck ‘False color rendering’ option, then You’ll see something like this: 
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Select the front most wall (it will start blinking) and with the contextual menu select ‘Hide this’: 

 
Do the same procedure with the other front most wall and roof: 

 
 Now adjust the "Saturation" at the value of 300 lux, copy the image in the clipboard and go to page 4 
of the report. Put the insertion point after the image, press Return, type "RENDERING", press Return 
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again, then paste the clipboard content. After resizing and cropping the pasted image in the report file 
you will see a new page: 

 
Come back to RoomLightingCalc, check the "False Colors rendering" box, hide the three front most 
surfaces (like before) and You’ll have the following: 

 
Copy the image in the clipboard and go to page 5 of the report. Put the insertion point after the image 
pasted before, press Return and paste the clipboard content (You can also hard-copy the color-scale at 
the bottom of the window and paste it in the report, like in the next figure): 
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Save the file and this is all! 
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5.2. Manage photometries 
This tutorial permits to import a photometric file, to do some manipulations on it and to export a full 
report. 

5.2.1.  Import, correct and save a photometric file.  

1. The first step consist in importing the 'demo.ldt' file from the catalogue pop-menu: 

 
2.       Let's correct the name in 'demo. 36x750mA LED' simply with a double-click on the table row 

to enter the edit mode. 
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3. Now let's rotate the photometry 90° azimuth to make the plan of the maximum emission (in the 
previous image, the plan of the blue curve, C=90°/270°) the main plan (C=0°-180°): from the 
'Operation' pop-menu 'Rotate +90° azimuth'. 

 
4. For coherence we need to rotate also the geometry 90° azimuth, through the 'x<>y' button in the 

fixture box: 

 

5.     Now we have to notice that the total power is equal to the lamp power: 

 
6. This may be or may be not an error, but for now we assume that this is the inconsistence of the 

EULUMDAT file, so let's correct the total power adding a 10% of power due to the ballast 
consumption: type '10%' in the 'Power W or %' edit field in the Fixture box and press return, to let 
the application calculate the real total consumption: 
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⇒ 

 

7. Select an image to link to this photometry by clicking the 'Image Link' button in the fixture box, 
and select the 'recessed60x60led.jpg' one in the folder suggested by the application. The button 
will change in 'Image Unlink' (this button now will be used to discard actual link) and the image 
box will be filled with the selected picture: 

 
8. At this point we can save the fixture in the open catalogue simply clicking the 'Save Fixture' 

button: remember that until now the active catalogue was not updated on disk, so we have to 
select the 'Save catalogue' pop-menu to make permanent the modifications. 

5.2.2. Examine photometry 

1. The user is able to choose the photometry representation through the 'View' pop-menu among the 
polar, Cartesian or table view: 
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2. Is it also possible to plot a single curve, both the C=0°/C=180° and C=90°/C=270° curves or 
all the C-curves through the 'Plot' pop-menu: let's select 'All curves' from the 'Plot' pop-menu and 
'Polar' from the 'View' pop-menu, and the Photometry box will present the following diagram... 

 
3. ...that may be copied in the pasteboard with the 'Copy photometry as PDF/PNG' commands in 

the 'Catalogue' pop-menu: 
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5.2.3. Export photometry protocol.  

1. It is possible to export in PDF the total report for the selected photometry, through the 'Export 
selected photometries' command in the Catalogue pop-menu: 

 
2.     Then select 'PDF report' as Format and the parameters following the next image: 
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3. The saved report will contain one page with the photometry summary, 12 pages presenting the I-
table and one page with the planar representation of the photometric solid: 
•  photometry summary: 

 
•     I-table: 
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  ...follows 11 pages 

• ...   planar representation of the photometric solid: 
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          That's all! 
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6. Appendix 

6.1. Appendix A: Analysis results 
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6.2. Appendix B: Luminaire protocol 

 

LIGHTING SOURCE PROTOCOL

Model: 325+316, miniTensoDOMO QUADRETT.arg. + miniTensoCIELI DIFF.
Catalog: CINI&NILS.ildolib

CIE classification: Semi-Direct
Total power: 120.00W
Dimensions: 20.2 x 22.5 x 10.0 cm
Luminous volume: 20.2 x 22.5 x 0.0 cm
Efficency: 43 %

Zonal fluxes [lm]:
- 0/30: 116.10 (11.11 %)
- 0/40: 213.45 (20.42 %)
- 0/60: 481.48 (46.06 %)
- 0/90: 838.16 (80.19 %)
- 90/120: 145.42 (13.91 %)
- 90/130: 186.95 (17.89 %)
- 90/150: 205.22 (19.63 %)
- 90/180: 207.08 (19.81 %)
- 0/180: 1045.24 (100.00 %)

Installed lamp/s:
- n.: 1
- type: Halogen
- name: linear
- socket: R7s
- power: 120.00 W
- flux: 2450 lm
- color temp.: 3000 K

Side shades:
- depth: 0.0 cm
- angle C=0: 0.0 cm
- angle C=90: 0.0 cm
- angle C=180: 0.0 cm
- angle C=270: 0.0 cm

Grid:
- xy dimensions: 0.0 x 0.0 cm
- depth: 0.0 cm

- 1 - Illuminando
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...follows all other fields 

LIGHTING SOURCE PROTOCOL

     |                                               C                                               |
gamma|      0|     10|     20|     30|     40|     50|     60|     70|     80|     90|    100|    110|
   0d|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|
   1d|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|
   2d|   54.1|   54.1|   54.1|   54.1|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|
   3d|   54.1|   54.1|   54.1|   54.0|   54.0|   54.0|   54.0|   53.9|   53.9|   54.0|   53.9|   53.9|
   4d|   54.1|   54.1|   54.0|   54.0|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|
   5d|   54.1|   54.1|   54.0|   53.9|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|
   6d|   54.2|   54.2|   54.1|   54.0|   53.8|   53.8|   53.7|   53.7|   53.7|   53.7|   53.7|   53.7|
   7d|   54.4|   54.3|   54.2|   54.0|   53.8|   53.8|   53.7|   53.6|   53.6|   53.6|   53.6|   53.6|
   8d|   54.6|   54.4|   54.3|   54.0|   53.8|   53.8|   53.6|   53.5|   53.5|   53.5|   53.5|   53.5|
   9d|   54.7|   54.5|   54.4|   54.1|   53.7|   53.7|   53.5|   53.4|   53.3|   53.3|   53.3|   53.4|
  10d|   54.9|   54.7|   54.5|   54.1|   53.7|   53.7|   53.5|   53.2|   53.2|   53.2|   53.2|   53.2|
  11d|   55.1|   54.9|   54.7|   54.2|   53.8|   53.8|   53.5|   53.1|   53.1|   53.1|   53.1|   53.1|
  12d|   55.4|   55.1|   54.8|   54.4|   53.9|   53.9|   53.5|   53.0|   53.0|   53.0|   53.0|   53.0|
  13d|   55.6|   55.3|   55.0|   54.5|   54.0|   54.0|   53.4|   52.9|   52.9|   52.8|   52.9|   52.9|
  14d|   55.9|   55.5|   55.2|   54.6|   54.0|   54.0|   53.4|   52.8|   52.8|   52.7|   52.8|   52.8|
  15d|   56.1|   55.7|   55.4|   54.8|   54.1|   54.1|   53.4|   52.7|   52.6|   52.6|   52.6|   52.7|
  16d|   56.9|   56.4|   55.8|   55.0|   54.2|   54.2|   53.4|   52.6|   52.5|   52.4|   52.5|   52.6|
  17d|   57.7|   57.0|   56.3|   55.3|   54.3|   54.3|   53.4|   52.6|   52.4|   52.3|   52.4|   52.6|
  18d|   58.4|   57.6|   56.8|   55.6|   54.4|   54.4|   53.4|   52.5|   52.3|   52.2|   52.3|   52.5|
  19d|   59.2|   58.2|   57.2|   55.8|   54.5|   54.5|   53.4|   52.4|   52.2|   52.1|   52.2|   52.4|
  20d|   60.0|   58.8|   57.7|   56.1|   54.5|   54.5|   53.4|   52.3|   52.1|   51.9|   52.1|   52.3|
  21d|   61.9|   60.5|   59.1|   57.0|   54.8|   54.8|   53.6|   52.3|   52.1|   51.9|   52.1|   52.3|
  22d|   63.7|   62.1|   60.5|   57.8|   55.2|   55.2|   53.7|   52.2|   52.0|   51.8|   52.0|   52.2|
  23d|   65.6|   63.8|   61.9|   58.7|   55.5|   55.5|   53.8|   52.2|   52.0|   51.7|   52.0|   52.2|
  24d|   67.5|   65.4|   63.4|   59.6|   55.8|   55.8|   54.0|   52.2|   51.9|   51.6|   51.9|   52.2|
  25d|   69.3|   67.1|   64.8|   60.4|   56.1|   56.1|   54.1|   52.1|   51.8|   51.5|   51.8|   52.1|
  26d|   70.6|   68.3|   66.0|   61.4|   56.9|   56.9|   54.5|   52.2|   51.8|   51.5|   51.8|   52.2|
  27d|   71.8|   69.5|   67.2|   62.4|   57.7|   57.7|   55.0|   52.2|   51.9|   51.5|   51.9|   52.2|
  28d|   73.0|   70.7|   68.4|   63.4|   58.5|   58.5|   55.4|   52.3|   51.9|   51.4|   51.9|   52.3|
  29d|   74.2|   71.9|   69.6|   64.4|   59.3|   59.3|   55.8|   52.3|   51.9|   51.4|   51.9|   52.3|
  30d|   75.4|   73.1|   70.8|   65.4|   60.1|   60.1|   56.2|   52.4|   51.9|   51.4|   51.9|   52.4|
  31d|   76.0|   73.6|   71.2|   66.0|   60.7|   60.7|   56.6|   52.4|   51.7|   51.1|   51.7|   52.4|
  32d|   76.6|   74.1|   71.7|   66.5|   61.4|   61.4|   56.9|   52.4|   51.6|   50.8|   51.6|   52.4|
  33d|   77.2|   74.7|   72.1|   67.1|   62.0|   62.0|   57.2|   52.5|   51.5|   50.5|   51.5|   52.5|
  34d|   77.8|   75.2|   72.6|   67.6|   62.6|   62.6|   57.6|   52.5|   51.4|   50.3|   51.4|   52.5|
  35d|   78.4|   75.7|   73.0|   68.2|   63.3|   63.3|   57.9|   52.5|   51.2|   50.0|   51.2|   52.5|
  36d|   78.9|   76.1|   73.4|   68.4|   63.4|   63.4|   57.9|   52.3|   50.9|   49.4|   50.9|   52.3|
  37d|   79.4|   76.6|   73.8|   68.6|   63.5|   63.5|   57.8|   52.2|   50.5|   48.8|   50.5|   52.2|
  38d|   79.8|   77.0|   74.1|   68.9|   63.6|   63.6|   57.8|   52.0|   50.1|   48.2|   50.1|   52.0|
  39d|   80.3|   77.4|   74.5|   69.1|   63.7|   63.7|   57.8|   51.9|   49.7|   47.5|   49.7|   51.9|
  40d|   80.8|   77.8|   74.8|   69.3|   63.8|   63.8|   57.7|   51.7|   49.3|   46.9|   49.3|   51.7|
  41d|   81.6|   78.5|   75.4|   69.6|   63.9|   63.9|   57.6|   51.3|   48.6|   46.0|   48.6|   51.3|
  42d|   82.4|   79.2|   76.0|   70.0|   64.0|   64.0|   57.4|   50.9|   48.0|   45.0|   48.0|   50.9|
  43d|   83.3|   79.9|   76.5|   70.3|   64.1|   64.1|   57.3|   50.5|   47.3|   44.1|   47.3|   50.5|
  44d|   84.1|   80.6|   77.1|   70.6|   64.2|   64.2|   57.1|   50.1|   46.6|   43.2|   46.6|   50.1|
  45d|   84.9|   81.3|   77.6|   70.9|   64.2|   64.2|   57.0|   49.7|   46.0|   42.2|   46.0|   49.7|
  46d|   86.6|   82.6|   78.5|   71.4|   64.3|   64.3|   56.7|   49.1|   45.2|   41.2|   45.2|   49.1|
  47d|   88.3|   83.9|   79.4|   71.9|   64.4|   64.4|   56.5|   48.5|   44.3|   40.2|   44.3|   48.5|
  48d|   90.1|   85.2|   80.4|   72.4|   64.5|   64.5|   56.2|   47.9|   43.5|   39.2|   43.5|   47.9|
  49d|   91.8|   86.5|   81.3|   72.9|   64.6|   64.6|   56.0|   47.3|   42.7|   38.2|   42.7|   47.3|
  50d|   93.5|   87.9|   82.2|   73.4|   64.7|   64.7|   55.7|   46.7|   41.9|   37.2|   41.9|   46.7|
  51d|   96.2|   89.8|   83.4|   74.2|   65.0|   65.0|   55.5|   46.0|   41.2|   36.3|   41.2|   46.0|

- 2 - Illuminando
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6.3. Appendix C: IES-NA data interchange format 
of: (Ian Ashdown, P. Eng. Research & Development Manager - Ledalite Architectural Products 

Incorporated 9087A - 198th Street - Langley, B.C. - Canada V1M 3B1 - Tel. (604) 888-6811 
- Fax. (604) 888-0566 - e mail: iashdown@ledalite.com - URL: http://www.ledalite.com ... 

Synopsis: The IESNA LM-63 photometric data file is an ASCII text file commonly used by North 
American lighting fixture manufacturers to distribute photometric information about their 
products. ... 

The Standard File Format IES ... is an ACII text file. There are three revisions, based on LM-63-1986, LM-
63-1991, and LM-63-1995. 

6.3.1. IES LM-63-1986 

The file format specification for the LM-63-1986 variant is: 

Id Description 

01 {label line 1} 

02 {label line 2} 

03 ... 

04 {label line n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 {# of lamps} {lumens per lamp} {candela multiplier} {# of vertical angles} {# of horizontal angles} 
{photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {ballast-lamp photometric factor} {input watts} 

12 {vertical angles} 

13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 ... 

17 {candela values for all vertical angles at nth horizontal angle} 

A detailed description of each line is presented in the following sections. 

6.3.2. IES LM-63-1991 

The file format specification for the LM-63-1991 variant is: 

Id Description 

00 IESNA91 

01 {Keyword [TEST]} 

02 {Keyword [MANUFAC]} 

03 ... 
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04 {Keyword n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 vertical angles} {# of horizontal angles} {photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {ballast-lamp photometric factor} {input watts} 

12 {vertical angles} 

13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 ... 

17 {candela values for all vertical angles at nth horizontal angle} 

The changes between LM-63-1986 and LM-63-1991 are: 

• Identifier line 00 ("IESNA91") was added to distinguish the file from LM-63-1986 photometric 
data files. 

• The free-form label lines (identifiers 01 through 04) were replaced with lines that begin with user-
defined keywords. 

A detailed description of each line is presented in the following sections. 

6.3.3. IES LM-63-1995 

The file format specification for the LM-63-1995 variant is: 

Id Description 

00 IESNA:LM-63-1995 

01 {Keyword 1} 

02 {Keyword 2} 

03 ... 

04 {Keyword n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 {# of lamps} {lumens per lamp} {candela multiplier} {# of vertical angles} {# of horizontal angles} 
{photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {future use} {input watts} 

12 {vertical angles} 
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13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 .. . 

17 {candela values for all vertical angles at nth horizontal angle} 

The changes between LM-63-1991 and LM-63-1995 are: 

• Identifier line 00 was changed to "IESNA:LM-63-1995") to distinguish the file from LM-63-1986 
and LM-63-1991 photometric data files and other (future) IESNA standard file formats. 

• The number of predefined keywords was expanded and new features (such as support for near-
field photometric data) introduced via the keyword mechanism. 

• The {ballast-lamp photometric factor} was changed to {future use}. 

A detailed description of each line is presented in the following sections. 

6.3.4. IES Standard File Format - Detailed Description 

All lines shall be terminated with a {CR}{LF} pair. (This is the text file convention for MS-DOS programming 
environments). 

An "identifier line" as presented in Section 2, "IES Standard File Format - Specification," may be consist of 
one or more ASCII text lines in the photometric data file. Multiple lines are typically present when the 
space needed to represent the values in the identifier line exceeds the allowable line length. 

The maximum length of any label / keyword line (including the {CR}{LF} terminating pair) is 82 characters. 
The maximum length of any other line (including the {CR}{LF} terminating pair) is 132 characters. 

6.3.4.1. File Format Identifier (Identifier Line 00) 
IES LM-63-1991 and LM-63-1995 photometric data files begin with a unique file format identifier line, 
namely "IESNA91" or "IESNA:LM-63-1995". IES LM-63-1986 does not have a file format identifier line. 

6.3.4.2. Label Lines / Keywords (Identifier Lines 01 Through 04) 
Label lines contain descriptive text about the luminaire, the lamp(s) used, and other descriptive comments. 
Keywords, which were introduced in LM-63-1991, require that each label line begins with a defined IES 
keyword in square brackets. For example: 

[TEST]  ABC1234 ABC Laboratories 

The keywords [TEST] and [MANUFAC] are required in LM-63-1991, but not in LM-63-1995. (Label lines 
are optional in LM-63-1986 and LM-63-1995.) The following keywords are a suggested minimum for LM-
63-1995: 

[TEST]  Test report number and laboratory 

[MANUFAC] Luminaire manufacturer 

[LUMCAT] Luminaire catalog number 

[LUMINAIRE] Luminaire description 

[LAMPCAT] Lamp catalog number 

[LAMP] Lamp description 

LM-63-1995 presents a list of predefined keywords that identify test-related data, luminaire product 
information, luminaire characteristics, and miscellaneous information. User-defined keywords are also 
permitted. 
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Details regarding the syntax of user-defined keywords are presented in IES LM-63-1995. The 
accompanying IES Standard File parser reads and stores, but does not interpret, keyword lines. 

6.3.4.3. TILT= (Identifier Line 05) 
The lamp output may vary as a function of the luminaire tilt angle. If so, then the photometric data file may 
provide photometric data multipliers for various tilt angles. The "TILT=" line uniquely delimits the end of 
label / keyword lines in the photometric data file. 

There are three variants of this line: 

• "TILT=NONE": The lamp output (presumably) does not vary as a function of the luminaire If 
TILT=NONE is present, the identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of 
angles and multiplying factors} 08 {angles}, 09 {multiplying factors} are not present in the 
photometric data file. 

• "TILT=INCLUDE": The lamp output varies as a function of the luminaire tilt angle. If TILT=INCLUDE 
is present, the identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of angles and 
multiplying factors} 08 {angles}, 09 {multiplying factors} are present in the photometric data file. 

• "TILT={filename}": The lamp output varies as a function of the luminaire tilt angle. If 
TILT={filename} is present (where "filename" is the name of a valid TILT photometric data file), the 
identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of angles and multiplying factors} 
08 {angles}, 09 {multiplying factors} are present in the identified and separate TILT photometric 
data file. 

6.3.4.4. Lamp-to-Luminaire Geometry (Identifier Line 06) 
This integer value indicates the orientation of the lamp within the luminaire as follows: 

1. Lamp base is either vertical base up or vertical base down when the luminaire is aimed straight 
down. 

2. Lamp is horizontal and remains horizontal when the luminaire is aimed straight down or rotated 
about the zero-degree horizontal plane. 

3. Lamp is horizontal when the luminaire is pointed straight down, but does not remains horizontal 
when the luminaire is rotated about the zero-degree horizontal plane. 

The lamp-to-luminaire geometry line is absent if TILT=NONE. 

6.3.4.5. Number of Pairs of TILT Angles and Multiplying Factors (Identifier Line 
07) 

This integer value indicates the total number of lamp tilt angles and their corresponding candela 
multiplying factors. It is absent if TILT=NONE. 

6.3.4.6. TILT Angles (Identifier Line 08) 
This line enumerates the (floating point) lamp tilt angles. It is absent if TILT=NONE. 

6.3.4.7. TILT Multiplying Factors (Identifier Line 09) 
This line enumerates the (floating point) candela multiplying factors for the corresponding lamp tilt angles. 
It is absent if TILT=NONE. 

6.3.4.8. Number of Lamps (Identifier Line 10) 
This integer value indicates the total number of lamps in the luminaire. 
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6.3.4.9. Lumens Per Lamp (Identifier Line 10) 
This floating point value indicates the rated lumens per lamp on which the photometric test was based. 
(This value is obtained from the lamp manufacturer's published technical data for the lamp, and does not 
represent the actual lumens emitted by the test lamp). 

If the luminaire has two or more lamps with different rated lumens per lamp, this value represents the 
average lumens per lamp for the luminaire. In the (very rare) cases of absolute photometry, this value is -
1. 

6.3.4.10. Candela Multiplier (Identifier Line 10) 
This floating point value indicates a multiplying factor that is to be applied to all candela values in the 
photometric data file (identifier lines 14 through 17). 

6.3.4.11. Number of Vertical Angles (Identifier Line 10) 
This integer value indicates the total number of vertical angles in the photometric data (identifier lines 14 
through 17). 

6.3.4.12. Number of Horizontal Angles (Identifier Line 10) 
This integer value indicates the total number of horizontal angles in the photometric data (identifier lines 
14 through 17). 

6.3.4.13. Photometric Type (Identifier Line 10) 
This integer value indicates the type of photometric web used for the photometric measurements as 
follows: 

1. Type C photometry 
2. Type B photometry 
3. Type A photometry 

Luminaries are photometered by locating the luminaire at the center of an imaginary sphere and 
measuring the light intensity (candela) values at grid points (the "photometric web') on the sphere's 
surface. The orientation of the luminary’s axes relative to that of the sphere determines the photometric 
type. 

Type C photometry is normally used for architectural and roadway luminaries. The polar axis of the 
photometric web coincides with the vertical axis of the luminaire, and the 0-180 degree photometric plane 
coincides with the luminary’s major axis (length). 

Type B photometry is normally used for adjustable outdoor area and sports lighting luminaries. The polar 
axis of the luminaire coincides with the minor axis (width) of the luminaire, and the 0-180 degree 
photometric plane coincides with the luminary’s vertical axis. 

Type A photometry is normally used for automotive headlights and signal lights. The polar axis of the 
luminaire coincides with the major axis (length) of the luminaire, and the 0-180 degree photometric plane 
coincides with the luminary’s vertical axis. 

It is important to note that these photometric types are *not* clearly defined in IES LM-63. All three 
versions refer the reader to the IES Lighting Handbook for descriptions of Type A and Type B photometry, 
and to CIE 27-1973 ("Photometry of Luminaries for Street Lighting") and CIE 43-1979 ("Photometry of 
Floodlights") for a description of Type C photometry. It then says that "Type C is the form in common use 
in the United States (although it was formerly referred to as Type A)." 

This is in contrast to CIE Publication 102-1993, "Recommended File format for Electronic Transfer of 
Luminaire Photometric Data," which clearly and unambiguously defines three types of photometry: A 
(alpha), B (beta), and C (gamma). The diagrams in CIE 102-1993 leave no doubt as to how their 
photometric webs are oriented with respect to the luminaire. Unfortunately, the IES LM-63 Type A 
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photometry is equivalent to the CIE 102-1993 Type C photometry, and the IES LM-63 Type C photometry 
is equivalent to the CIE 102-1993 Type A photometry. 

6.3.4.14. Units Type (Identifier Line 10) 
This integer value indicates the units used for the dimensions of the luminous opening in the luminaire as 
follows: 

1. Feet 
2. Meters 

6.3.4.15. Luminous Opening Dimensions (Identifier Line 10) 
While the term "luminous opening" is somewhat ambiguous for many architectural luminaries and other 
light sources, it is useful in calculating average luminaire luminances and modeling the luminaries as 
homogeneous area light sources. 

6.3.4.15.1. Luminaire Width 
This floating point value indicates the distance across the luminous opening of the luminaire as measured 
along the 90-270 degree photometric plane. 

6.3.4.15.2. Luminaire Length 
This floating point value indicates the distance across the luminous opening of the luminaire as measured 
along the 0-180 degree photometric plane. 

6.3.4.15.3. Luminaire Height 
This floating point value indicates the average height of the luminous opening of the luminaire as 
measured along the vertical axis. 

6.3.4.15.4. Nonrectangular Luminous Openings 
The luminous opening is normally considered to be rectangular. However, other predefined shapes can 
be modeled by specifying one or more of the above dimensions as zero or negative floating point 
numbers as follows:  

Width Length Height Description 

 0 0 0 Point  

w l h rectangular (default) 

 -d 0 0 Circular (where d = diameter of circle)  

-d 0 -d Sphere (where d = diameter of circle)  

-d 0 h Vertical cylinder (d = diameter of cylinder) 

 0 l -d Horizontal cylinder oriented along lum.length  

w 0 -d Horizontal cylinder oriented along lum.width  

-w l h Ellipse oriented along luminaire length 

 w -l h Ellipse oriented along luminaire width 

 -w l -h Ellipsoid oriented along luminaire length  

w -l -h Ellipsoid oriented along luminaire width  

See 6.3.3 IES LM-63-1995 IES for detailed descriptions and diagrams. 
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6.3.4.16. Ballast Factor (Identifier Line 11) 
This floating point value indicates the ratio of the lamp lumens when operated on a commercially-
available ballast, to the rated lamp lumens as measured by the lamp manufacturer using a standard 
(reference) ballast. 

All candela values in the photometric data file (identifier lines 14 through 17) must be multiplied by the 
ballast factor before the candela values are used in an application program. 

6.3.4.17. Ballast-Lamp Photometric Factor / Future Use (Identifier Line 11) 
In LM-63-1986 and LM-63-1991, this floating point value indicates the ratio of the lamp lumen output 
using the given ballast and lamp type used to generate a photometric report, to the lumen output of the 
same luminaire with the ballast and lamp type used for photometric testing. 

In LM-63-1995, it was recognized that most lighting manufacturers incorporate the ballast-lamp 
photometric factor in the preceding ballast factor and set the ballast-lamp photometric factor to unity. 

Consequently, the ballast-lamp photometric factor was designated as being for future use and the value 
set to unity to be compatible with previous releases of LM-63. 

All candela values in the photometric data file (identifier lines 14 through 17) must be multiplied by the 
ballast-lamp photometric factor before the candela values are used in an application program. 

6.3.4.18. Input Watts (Identifier Line 11) 
This floating point value indicates the total power (measured in watts) consumed by the luminaire, as 
measured during the photometric test (the input watts value is *not* adjusted by the ballast factor or 
ballast-lamp photometric factor, even though the power consumption of a luminaire may change if the 
measured candela values are modified). 

6.3.4.19. Vertical Angles (Identifier Line 12) 
This line enumerates the (floating point) vertical angles. For Type C photometry, the first vertical angle will 
be either 0 or 90 degrees, and the last vertical angle will be either 90 or 180 degrees. 

For Type A or B photometry, the first vertical angle will be either -90 or 0 degrees, and the last vertical 
angle will be 90 degrees. 

6.3.4.20. Horizontal Angles (Identifier Line 13) 
This line enumerates the (floating point) horizontal angles. 

For Type C photometry, the first value is (almost) always 0 degrees, and the last value is one of the 
following: 

0° There is only one horizontal angle, implying that the luminaire is laterally symmetric in all 
photometric planes; 

90° The luminaire is assumed to be symmetric in each quadrant; 

180° The luminaire is assumed to be bilaterally symmetric about the 0-180 degree photometric plane; 

360° The luminaire is assumed to exhibit no lateral symmetry (1). 

A luminaire that is bilaterally symmetric about the 90-270 degree photometric plane will have a first value 
of 90 degrees and a last value of 270 degrees. 

For Type A or B photometry where the luminaire is laterally symmetric about a vertical reference plane, 
the first horizontal angle will be 0 degrees, and the last horizontal angle will be 90 degrees. 
                                                
1 This is an error in the draft IES LM-63-1995 standard, because the 360-degree plane is coincident with the 0-degree plane. It 
should read "greater than 180 degrees and less than 360 degrees" 



  Appendix 

User Guide © 2014-2018 78 Marcello Brocato and Ecleti - Roberto Panetta 

For Type A or B photometry where the luminaire is not laterally symmetric about a vertical reference 
plane, the first horizontal angle will be -90 degrees, and the last horizontal angle will be 90 degrees. 

6.3.4.21. Candela Values (Identifier Lines 14 Through 17) 
These lines enumerate the (floating point) candela values. There is one line for each corresponding 
horizontal angle, and one candela value for each corresponding vertical angle. 

6.3.5. IES Standard File Example 

The following is an example of an IES LM-63-1995 photometric data file: 

 
The following is an example of an IES LM-63-1995 photometric data file: 
 
IESNA:LM-63-1995 
[TEST] ABC1234 ABC Laboratories 
[MANUFAC] Aardvark Lighting Inc. 
[LUMCAT] SKYVIEW 123-XYZ-abs-400 
[LUMINAIRE] Wide beam flood to be used without tilt 
[LAMPCAT] MH-400-CLEAR 
[LAMP] Metal Halide 400 watt 
[BALLASTCAT] Global 16G6031-17R 
[BALLAST] 400W 277V MH 
[MAINTCAT] 4 
[OTHER] This luminaire is useful as an indirect flood 
[MORE] and to reduce light pollution in down light 
[MORE] applications. 
[SEARCH] POLLUTION SPORTS INDIRECT 
[BLOCK] 
[LUMCAT] TENNISVIEW 123-XYZ-abc-400 
[LUMINAIRE] Wide beam flood for indirect applications. 
[ENDBLOCK] 
TILT=INCLUDE 
1 
13 
0 15 30 45 60 75 90 105 120 135 150 165 180 
1.0 .95 .94 .90 .88 .87 .98 .87 .88 .90 .94 .95 1.0 
1 50000 1 5 3 1 1 .5 .6 0 
1.0 1.0 495 
0 22.5 45 67.5 90 
0 45 90 
10000 50000 25000 10000 5000 
10000 35000 16000 8000 3000 
10000 20000 10000 5000 1000 
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6.4. Appendix D: EULUMDAT data interchange format 
of: Zumtobel Licht's COPHOS Development Team, http://www.cophos.co.at  

Synopsis: Proposal for a data format for exchange of luminaire data (interior, exterior, and/or road 
lighting luminaries) under the operating systems ms-dos 2.xx/3.xx under condition of 
unequivocal coordination between luminaire and data set...  

NOTE: Each of the following fields is an ASCII string that is terminated with an MS-DOS 'CR+LF' pair. 

N. Description N.character 
1 Company ident./data bank/version/format identif. max. 78 

2 

Ityp = Type indicator: 
1 ... point source with symmetry about the vert.axis 
2 ... linear luminaire 
3 ... point source with any other symmetry (only linear luminaries, Ityp = 2, are being 
subdivided in longitudinal and transverse directions) 

1 

3 

Isym = Symmetry indicator: 
0 ... no symmetry 
1 ... symmetry about the vertical axis 
2 ... symmetry to plane C0-C180 
3 ... symmetry to plane C90-C270 
4 ... symmetry to plane C0-C180 and C90-C270 

1 

4 Mc = Number of C-planes between 0° e 360° (usually 24 for interior, 36 for road 
luminaries) 2 

5 Dc = Distance between C-planes (Dc = 0 for non-equidistantly available C-planes) 5 
6 Ng = Number of luminous intensities in each C-plane (usually 19 or 37) 2 

7 Dg = Distance between luminous intensities per C-plane (Dg = 0 for non-equidistantly 
available luminous intensities in C-planes) 5 

8 Measurement report number max. 78 
9 Luminaire name max. 78 
10 Luminaire number max. 78 
11 File name 8 
12 Date/user max. 78 
13 Length/diameter of luminaire (mm) 4 
14 Width of luminaire b (mm) (b = 0 for circular luminaire) 4 
15 Height of luminaire (mm) 4 
16 Length/diameter of luminous area (mm) 4 
17 b1 = Width of luminous area (mm) (b1 = 0 for circular luminous area of luminaire) 4 
18 Height of luminous area C0-plane (mm) 4 
19 Height of luminous area C90-plane (mm) 4 
20 Height of luminous area C180-plane (mm) 4 
21 Height of luminous area C270-plane (mm) 4 
22 DFF = Downward flux fraction (%) 4 
23 LORL = Light output ratio luminaire (%) 4 
24 Conversion factor for luminous intensities (depending on measurement) 6 
25 Tilt of luminaire during measurement (road lighting luminaries) 6 

26 n = Number of standard sets of lamps (optional, extendable on company-specific 
basis) 4 

26a Number of lamps n * 4 
26b Type of lamps n * 24 
26c Total luminous flux of lamps (lm) n * 12 
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26d Color appearance / color temperature of lamps n * 16 
26e Color rendering group / color rendering index n * 6 
26f Wattage including ballast (W) n * 8 

27 DR = Direct ratios for room indices 0.6÷5 (for determination of luminaire numbers 
according to utilization factor method) 10 * 7 

28 Angles C (beginning with 0°) Mc * 6 
29 Angles G (beginning with 0°) Ng * 6 

30 

Luminous intensity distribution (cd/klm) 
(Mc2-Mc1+1)*Ng*6 with: 
Isym = 0: Mc1 = 1 Mc2 = Mc 
Isym = 1: Mc1 = 1 Mc2 = 1 
Isym = 2: Mc1 = 1 Mc2 = Mc/2+1 
Isym = 3: Mc1 = 3*Mc/4+1 Mc2 = Mc1+Mc/2 
Isym = 4: Mc1 = 1 Mc2 = Mc/4+1 
 

 

6.4.1. EULUMDAT Standard File Example 

 The following is an example of an EULUMDAT photometric data file (the file is splitted into 4 columns for 
clarity): 
LED 
2 
1 
24 
15 
31 
3.0 
LED00004 
Ipotesi 2S MH-T 
-- 
LED00004 
21.12.90/Lue 
300 
180 
160 
244 
146 
0 
0 
0 
0 
100 
51.9 
1.0 
0.0 
1 
1 
CDM-T 70W/83 
6200.0 
- 
- 
0.0 
0.83282 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.86265 
0.88517 
0.91294 
0.92490 
0.93917 
0.94937 
0.95872 
0.96163 
0.96680 
0 
15 
30 
45 
60 
75 
90 
105 
120 
135 
150 
165 
180 
195 
210 
225 
240 
255 
270 
285 
300 
315 
330 
345 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.0 
3.0 
6.0 
9.0 
12.0 
15.0 
18.0 
21.0 
24.0 
27.0 
30.0 
33.0 
36.0 
39.0 
42.0 
45.0 
48.0 
51.0 
54.0 
57.0 
60.0 
63.0 
66.0 
69.0 
72.0 
75.0 
78.0 
81.0 
84.0 
87.0 
90.0 
7296.4 
6035.9 

3432.3 
1260.4 
478.3 
254.6 
174.4 
137.3 
117.1 
103.7 
87.5 
74.5 
67.3 
61.6 
55.6 
38.2 
12.4 
4.2 
2.2 
2.0 
1.9 
1.9 
0.3 
0.0 
0.0 
0.0 
0.0 
0.2 
0.0 
0.0 
0.0 
 
 
 
 

 


